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WHAT IS AMERICA ALIVE?    

Welcome to America Alive    2.0!    For those of you new to the product, America Alive    is an interactive tour and 
educational reference tool of the United States.      Those of you already familiar with America Alive    1.0 will notice 
several enhancements we have made to the product.    In addition to updating text, slides, and maps in the interactive 
tour, we have added a set of learning activities that challenge your knowledge of the United States.      To look at 
more detailed descriptions of these two main components of America Alive    check out the Introduction and Tutorial 
("2torial") components from the Main Menu.    Enjoy your experience with America Alive!



MENUS

This section describes the menus on the top of the screen. 

File and Edit
Most of the functions available under these two menu items are related to customization.    You can read 
more about this in Section 3.

Window
This menu contains a list of windows that can be opened and brought forward at any time.    The available 
windows are the Main Map, Sub Maps (States and Cities), Slides, Text, and Movies

If a window is checked then it is already opened.    If it is not visible then it is behind another window.    
Selecting this window again will bring it to the front of the screen.

Slide
This menu contains a list of operations that can play and stop slides.    You can read more about this in Slide
Window section

Text
This menu allows you to change Text Categories.    You can read more about this in Text Window section.

Sound
This menu contains a list of operations that can play and stop sound.    You can read more about this in the 
Control Button section.

Movie
This menu contains a list of operations that can play and stop movies.    You can read more about this in the 
Movie Window section.

Location
Users can use this menu to quickly go to any state, city, park or attraction.    



CONTROL BUTTONS

The Control Buttons for all locations are located in the 'Tool Bar' along the top of the screen.    The Control Buttons 
on the Tool Bar include from left to right:

Main Map Selection Buttons
State Button
City Button
Park Button
Attraction Button

Four Media Buttons
Slide Button
Text Button
Sound Button
Movie Button

Go To Button

Return to Main Menu Button    
    
Main Map Selection Buttons

The first four buttons on the left activate the State, City, Park, and Attraction Main Maps, respectively.

By clicking on this button, the Main Map will display states.

By clicking on this button, the Main Map will display cities.

By clicking on this button the Main Map will display parks.

By clicking on this button the Main Map will display attractions

Media Buttons
These four buttons, located in the center of the Tool Bar, are used to open the slides, text, and movie 
windows and to play the sound for any active map.    A button will appear dimmed if the information is not 
available for the location.    

Slides Button:    Click on the first button to bring up the slide window and a slide show of the active 
location.

Text Button:    Click on the second button to bring up the text window.    The text contains information about
the state, city, park, or attraction displayed in the active map.

Sound Button:    Sound is the third button from the left.    Click the sound button to turn sound on or off.



Movie Button:    Click on the fourth button to bring up the movie window.    This shows a movie about the 
location displayed in the active map.

Go To Button

The Go To Button will allow you to quickly access another location from an alphabetical list.

Return To Main Menu Button

The Go To Button will allow you to quickly access another location from an alphabetical list of all the 
locations in America Alive.

Note:    To close a window, double-click on the small box in the upper left hand corner of the window you wish to 
close.

State Location Button

The State Location Button will appear in the upper right hand corner of the Tool Bar when you are viewing 
a City Map.    Clicking on the State Location Button will quickly take you to the State Map where the City 
you are viewing is located..



MAPS

The first map that you see when the TourUSA module of America Alive GUIDisc opens is the USA State 
Map.    This map has buttons identifying each State.    Click on a State button to open a map for that state.    
You will see location buttons on the main State, City, Park and Attraction Maps as well as many of the 
individual State Maps.

Location
The title of the map is written in the bar across the top of the map.    

States



Map Behavior:      State Maps have several things differentiating them from the City Maps.    The State Maps have 
location buttons such as those on the Main Map.    When you click on these location buttons, you will go to the 
specific city, park or attraction within that state shown on that button.

Traveling Onward:      There are several ways of moving on from the State Map.    You may go to an 
adjacent state by clicking the button for the neighboring state or you can choose a location from the Go To Button on
the Tool Bar.    Another option is to click on any part of the main USA Map to bring that map forward, then select a 
location from that map.

Cities



Map Behavior:      You can explore several of the sites depicted on each city map.    When the mouse cursor changes
to an "eye," you can click on the site to see an animation.    When the mouse cursor changes to an "ear with a hand," 
you can click on that spot to hear about the landmark or building depicted.

Traveling Onward:      Clicking on the State Location Button in the upper right hand corner of the Tool Bar
will take you to the State Map where the city you are viewing is located.    (See State Location Button in the Control 
Button heading.)    You can move to another location by going to the Go To Button of the Tool Bar.    Another option 
is to click on any part of the main USA Map to bring that map forward so that you can select a location from that 
map.

Parks and Attractions



Map Behavior:    When you select a park or attraction, a map is shown that is titled with the park or attraction that 
you have chosen.    An icon will appear next to the location on the map indicating the type of terrain or feature of the 
location.

Traveling Onward:    To get back to the state the park or attraction is in, click on the State Location Button
in the top right corner of the Tool Bar.    Clicking the location buttons on the map will take you to other places within
that state.    You can also choose a location by clicking the Go To Button on the Tool Bar.    Another option is to click 
on any part of the main USA Map to bring that map forward so that you can select a location from that map.    



TEXT WINDOW

Text Buttons
When you bring up the Text Window, you will see a row of buttons across the top representing different 
categories of information.    Click on these buttons to switch Text Categories.

Text Categories
Text Categories for the States include (from left to right):

General Information & History

Climate & Geography

Sights & Recreation

People & Culture

Travel Information

Government & Economy

Text Subcategories

What are they?

The Text Subcategories are displayed in green uppercase letters just under the Text Category icons.
A text subcategory is a quick way to get to the beginning of a specific topic you are interested in.

How To Use The Text Subcategories

By clicking on one of the topics of interest, the text will scroll to the beginning of that topic.    You 
can jump between topics easily this way.

Find

The last button of the Text Window (the furthest right) is the Find Button.    Click the Find Button to search 
for a word or group of words in the displayed text category.    When you click the Find Button, a Find 
dialog box will appear.



Type in the word or words that you are looking for and click the find button or return on the keyboard.    If 
the text exists in that text category, you will see a message indicating how many instances of that text has 
been found.    The instances are colored in red in the body of the text, so that when you scroll through the 
text you can spot them easily.

If the word is not in the text, you will be notified that the text could not be found at the bottom of the Find 
box.

To exit the find mode, click on Close in the Find dialog box.



SLIDE WINDOW

Window Behavior
You can open the Slide Window by clicking on the Slide Button on the Tool Bar.    You can also bring up 
the Slide Window from the Window Menu or by selecting Play from the Slide Menu.    This will bring up 
the active map's slide show.    The number of slides available in the slide show is indicated at the top of the 
window.

Controlling the Slides
The Slide Window includes a control bar at the bottom.    To start the slide show, click on the triangular 
shaped "play" button at the far left.    Once the slide show is started, the "play" button becomes a square 
shaped "stop" button.    You can click on this "stop" button to stop the slide show at the currently displayed 
slide.    You can also stop the slides by selecting Stop in the Slide Menu.    To re-start the slides, click on the 
play button again or select Play in the Slide Menu.    The thumb on the control bar will move to the right 
after each slide is displayed.    You can control the thumb along the slider to go backward or forward 
through the slide show.

The Loop command, located under the Slide Menu allows you to play the slide show continuously until you
stop it.    If Loop is not activated, the slide show will stop after it has shown all the slides once. 



MOVIE WINDOW

Window Behavior
You can open the Movie Window by clicking on the Movie Button on the Tool Bar.    You can also select 
Movie from the Window Menu.    This will play the active map's movie.    Alternatively, you can select 
"play" from the Movie Menu Item.    The movie button on the Tool Bar for the location will appear dimmed
if a movie is not available for that location.

Controlling the Movie
The movie window includes a control bar at the bottom.    To start the movie, click on the triangular shaped 
"play" button to the far left.    Once the movie is started, the "play" button becomes a square shaped "stop" 
button.    You can click on this "stop" button to stop the movie at the current frame.    You can also stop the 
movies by selecting Stop in the Movie Menu.    To start the movie, click on the Play button again or select 
Play in the Movie Menu.    The Slider thumb (the star embossed icon on the control bar) will move to the 
right as the movie plays.    You can move the thumb to the right or left to go forward or backward in the 
movie.

The Zoom command in the Movie Menu can resize the movie window to either half or double the normal 
default size.

The Loop command, located under the Movie Menu allows you to play the movie continuously until you 
stop it.    If Loop is not activated, the movie will stop after playing once.

The Mute command under the Movie Menu allows you to turn off the sound for the movie.    To restore the sound, 
select Mute again. 



FILE MENU ITEMS

Export Text
Export text can be used to transfer your information.

Export text will save all of the selected text from the current location to an Export file.    When you select 
Export Text, an Export Text File dialog box will open allowing you to designate where you would like to 
save the Export file.

The printing commands are also located under the File Menu.    For more information, refer to the section 
entitled Printing.



EDIT MENU ITEMS

In the Edit Menu, Copy functions in the same way this command functions in other word processing 
programs.

You can also set your preference options by selecting Preferences...    For more information, refer to the 
section entitled Preferences.



PRINTING

Print Text
1.    While the Text Window is open, go to Print Text... from the File Menu.

2.    A Print dialog box will appear.

3.    Select OK and it will print the text currently displayed in the window.

Print Map
1.    Go to Print Map... from the File Menu.

2.    You will then be given a menu from which you choose the map you wish to print, the Main Map or a 
State or City Map if one is active.

3.    Select the map you wish to print and a Print dialog box will appear.

4.    Select OK and it will print the active map.

Printing Tips
When you are printing a map select gray scale printing for best results.
When printing maps you need to have the entire window visible and not overlapped by another window.



PREFERENCES

Slides
Here you can select the delay in between slides and also the size of the border.    The border is measured in 
pixels.

Dial To
Select Modem to dial telephone numbers given in the TourUSA travel sections through a modem.    
Speaker will play the dialing tone through the computer speaker.    Hold the telephone receiver next to the 
speaker when dialing from the program

Comm Port
You can select a communication port that your modem is set to.

Phone
You can dial a phone number listed in the Travel Information directly by clicking on the number.    To set 
the preferences for this feature see below:

Area Code
Select Area Code to enter the area code you are calling from.    The program will not dial the area code if 
this number matches the number in the parentheses of the phone number.

Prefix
Select this if there is a number that must be dialed before all phone calls, local or long distance.    

Long Distance
Select this option if you need to dial a long distance prefix.    The program will dial this number if the 
number in the area code does not match the number in the parentheses of the phone number.

Save Current Window Position
When this item is checked, the placement of the submap, slide, text, and movie windows will be saved in 
positions you last moved them to.

Play Button Click Sound
When this item is checked, there will be a click sound every time you click a button.



Play Text Chime Sound
When this item is checked, there will be a chime sound every time you click on a Text Index.

Play Voice-Over Sound
When this item is checked, there will be a voice-over sound that says the name of the location you have 
selected every time you go to a location.



TECHNICAL SUPPORT

 
The GUIDiscs are designed to run on any computer system that meets the minimum system requirements.      
        
However, not all systems are exactly the same, and as a result, some systems may contain hardware or software that  
conflicts with running the GUIDisc.      
      
Performance of the program can also vary depending on the type of CD-ROM drive, video card, and sound card you
are    
using.    Should you experience any problems running the program, please note the following troubleshooting steps. 
Also, please handle the CD carefully as scratches may cause the data to be corrupted.        
        
If you received our software as part of a bundled kit, your reseller is the most appropriate source to provide support   
on total compatibility issues.        
        
Contact your dealer or retailer for hardware or system related questions.            
        
    
Technical Support        
        
Do not run any other programs while you are using our program for optimal performance.        
        
Minimum system requirements:        
        
- Windows compatible 486/25Mhz    CPU or higher        
- Windows 3.1        
- MS-DOS 5.0 or higher        
- 4 MB RAM with virtual memory on        
- 640x480 SVGA resolution with 256 colors (8-bit)        
- Sound Blaster compatible sound card        
- Mouse        
- Double-Speed CD-ROM drive        
- Speakers        
        
Most of the technical support problems occur when your system is running a "unique" non-standard driver for    
performance boost which has not been tested for multimedia compatibility.    The largest incompatibility occurs in    
proprietary video hardware, software and setup.        
        
    
TROUBLESHOOTING        
        

Tips:        
        
- After installing our program, restart the computer to refresh memory requirements.        
        
- If our program used to work but has stopped working, then you have recently installed a program that is 
incompatible      with ours.        
See Driver Conflict.        
    
    
Graphics, Video, and Display:        
        
In general, if you have any graphics problem, try running it with a SVGA 640x480 resolution with 256 colors. Do 
not run it in millions of colors. Also make sure you have the latest driver for your video card from its manufacturer.   



        
To reset your display to 256 colors, select "Main" in Program Manager desktop:        
- Select "Windows Setup"        
- Select "Options"        
- Select "Change System Setting"        
- Select "Display" and choose the right video display driver.        
        
- GUIDisc is designed to run at 256 colors or above.      
However, some video drivers cause memory errors. If this occurs, try running the GUIDisc at 256 colors.        
        
- America Alive 2.0 Tornado Watch:    
If you are experiencing an animation problem, try SVGA drivers from    Microsoft Windows or different color depth.
(i.e. 256, 64K, or 16.7M colors)        
        
- If you use the DIAMOND Viper VLB video card, make sure the Viper video driver is version 1.05 or later.      
The previous versions of the drivers will give driver errors when executing GUIDisc.        
        
- If you use the ATI Graphics Ultra Pro video card, make sure the ATI video driver is build 67 or later.          
The previous versions of the drivers will give "out of memory" errors when executing GUIDisc.        
        
- To get the highest display quality for slides, video and graphics, change your video setting to 16-bit (thousands or   
millions of color).    During our product development, we anticipated that 16-bit video will be the standard in the 
future and thus optimized our compression under 16-bit    video.    
Unfortunately, this means users with 8-bit (256 color) will not be able to see our video, graphics and slide at its 
highest resolution.    However, you will appreciate our efforts when you do upgrade to a 16-bit video graphics card.   
    
    
    
Driver Conflicts:       
        
- Try installing a clean new Windows directory under a    different name (e.g. CleanWin) and then reinstall our 
program again in the new Windows directory.    Refer to your hardware instructions on how to create a new or 
"clean" Windows directory.        
        
        
Memory error:        
        
- Low MCI Memory Suggestions:    
                  
    - To check memory size, exit Windows and type "MEM".        
        Memory available is the largest executable program size.    
    - Try closing other windows or tasks (ALT-Tab to check)        
    - Use Program Manager as the shell        
    - Use a generic video driver (like Super VGA)        
    - Have at least 580K of conventional memory available        
    - It is necessary to have Video for Windows 1.1      
        installed to run GUIDisc.    
    
    - If your system has a Central Point PCTools for Windows Anti-Virus program in memory,    GUIDisc will alert 
you that the *.EXE file has been modified. GUIDisc has no virus.        
    - GUIDIsc works fine with Norton and Microsoft anti-virus programs and will not give an alert message.    
    - You may need to uninstall all unneccesary utilties to have 580K of conventional memory available.    
        
Error Messages (Refer to memory section for low MCI Memory suggestions) and solutions are listed in order of 
priority:        
        



- "General Protection Fault"          
    - This may be a hardware problem which we cannot solve.          

- See Driver Conflict.        
        
- "MCI Error 264 - Out of Memory -"      
    
    - Free up more conventional memory. You should have at    least 580K available.        
    - Switch to a VGA video driver instead of an SVGA video driver, under Windows Setup.        
    - Use Program Manager as your shell. Change this in the system.ini file.    
    
- "MCI Error 296 - Bad Integer -":    
    
    - There are drivers in your Windows directory that are incompatible with Video for Windows.        
    - There is no easy way to find the corrupt file. If    our program used to work, but doesn't work    anymore, then a 
recently installed program is causing the problem.        
    - If the program has never worked, then look in your    C:\WINDOWS directory and the C:\WINDOWS\SYSTEM 
directory to find the offending file or,        
    - See Driver Conflict.        
    
- All other MCI Errors:    
        
- Other MCI Errors would be initiated by either MCI Error 264 or 296.        
        
- "Can't Load System Control DLL":      
    
    -There are DLL in your Windows directory that are incompatible with our DLLs.        
    - There is no easy way to find the corrupt file. If    our program used to work, but doesn't work    anymore, then    a 
recently installed program is causing the problem.        
    - If the program has never worked, then see Driver    Conflict.    
Create a new Windows directory and reinstall our program.        

      
- "THREED.VBX file is out of date" or "*.VBX is out of    date":    
      
    -Two files involved are GRID.VBX and    THREED.VBX        
    -You have multiple THREED.VBX files in you system, due to improper installation from other software titles. 
Our software is finding the old version and can not operate with it.            
    -Locate all "THREED.VBX "files in you computer and rename them (in case you need to reverse naming again) 
and then reinstall our program.    The proper location for all      
"*.VBX" files should    be in the Windows systems directory.        
    - Rename all *.VBX files. Rename THREED.VBX to THREED.OLD; and GRID.VBX to GRID.OLD. They are 
usually located in two directories: C:\WINDOWS and    C:\WINDOWS\SYSTEM.      
Then reinstall the program.        
    - See Driver Conflict.        
        
- Other VBX file is out of date:    
    - Refer to the problem above.        
    
    
Printing:        
        
- To print maps, please make sure the "Use System ID Palette" is selected in Preferences to ensure better    print 
quality.        
        
- To print graphics in a higher quality, capture the screen image into the clip board and then paste it into a high 
resolution graphics program. Print the image from the graphics program.        
        



- To capture images, use the "PrintScreen" key or any other commercially available screen capturing programs.        
        

Example: Unable to print maps - "we have problems with the HP500 series inkjet printers"        
        

Solutions: In order to print maps using these printers, you have to copy the image to the    clipboard using    
the "print screen" button. You can then enter another application such as    Paintbrush and paste the image. From this 
application, you can print the image on the map.        
        
        
Sound:       
        
- GUIDisc does not require a sound card, but to get the most out of it you should use a sound capable machine or 
sound card.        
                
        
Remember, our free on-line technical support is only available within 90 days of purchase.    After 90 days, support 
is available via fax, mail, or voice mail.    Contact    your dealer or supplier first for primary technical support.    To 
receive support from MediAlive, be sure you send in the warranty registration card.            
        
        
- For buyers of our jewel case package in bundles: Please contact your bundling supplier first for technical support.   
        
        
All of the above technical support question are known problems we are able to support. We can not support technical
issues that are unknown to our industry or does not invlove our product.        
        
              
Our office hours are:    Mon-Fri, 9-5, Pacific Standard Time.        
    
Fax:                  408-752-8501        
        
AppleLink: D3777        
        
CompuServ:    71762,3512        
    
Most of our international customers prefer using AppleLink and Compuserve.    However, since we check our    E-
Mail only weekly, if this is an emergency, please leave a phone message to remind us to check E-mail.    
    
MediAlive is a software division of CD-Technology. Inc.    
    
Copyright 1995    January



TEXT MENU ITEMS

Text Categories
The Text Menu items are used to view the Text Windows.    Once you open a Text Window for any location, 
the Text Categories under the Text Menu will become enabled.    By selecting any of the Text Categories 
under the Text Menu, you can change the Text Category that you are currently viewing.

Find

The last button of the Text Window (the furthest right) is the Find Button.

Click the Find Button to search for a word or group of words in the displayed text category.    When you 
click the Find Button, a Find dialog box will appear.

Type in the word or words that you are looking for and click the find button or return on the keyboard.    If the text 
exists in that text category, you will see a message indicating how many instances of that text has been found.    The 
instances are colored in red in the body of the text, so that when you scroll through the text you can spot them easily.

To exit the find mode, click on    Close in the Find dialog box.



ENJOY THE AMERICA ALIVE ACTIVITIES!

This brand new module of America Alive    is a set of five engaging activities that challenge your knowledge about 
the United States.    These activities are organized thematically and are appropriate for a range of ages.    

The Activity Menu is a display of five different billboards.    Click on one of the billboards to go to the activity 
indicated.    A recommended age range for each activity is given below.    For more detailed information see the 
section for each activity.

Campfire Karaoke  is appropriate for any age.
Tornado Watch    is appropriate for ages 8 on up.
State Capital Quest    is appropriate for ages 7 on up.
What State Can It Be?    is appropriate for ages 5 on up.
Dizzy Aunt Lulu's Photo Album    is appropriate for ages 8 on up.



CAMPFIRE KARAOKE

Folksongs and music have been an important part of American culture.    Sing-along with Campfire 'Karaoke' Carson
and learn about some of America's classic folksongs and the national anthem.    Campfire Karaoke is a wonderful 
way to learn songs that children can entertain themselves with even after the computer is turned off.    Imagine that!

The Introduction Screen

To select a song to sing-along with, click on one of the animals in the Introduction Screen.    The animals are 
associated with the following songs:

The Owl:    Shenandoah
The Ground Squirrel:    Oh, Susanna!
The Raccoon:    Git Along, Little Dogie
The Dog:    Yankee Doodle
The Eagle:    The Star Spangled Banner

Song Description
You will hear a short description of the song after clicking on one of the animals.    Click on the 'KaraOKe' button to 
go to the start up screen for the song.

Play the Song



To play the song, click on the triangular shaped button (Play Button) at the left bottom corner of the screen and 
Sing-Along with    'Karaoke' Carson!    You can go backwards and forwards in the song by dragging the thumb on the
control bar.

End of Song
After the song is done, you can replay the song by clicking the Play Button again.    Or you can go back to the Song 
Menu by clicking on the Return Button. 

Pause or Stop the Song    
To pause the song, click on the square shaped button (Stop Button) at the left bottom corner of the screen!    You will
stop at the current screen display.    

End of Song  
After the song is done, you can replay the song by clicking the Play Button again.    Or you 
can go back to the Song Menu by clicking on the Return Button.

Exiting the Activity
Click on the Exit sign of the Campfire Introduction screen to go back to the Activity Menu.

Stopping the Activity
If you want to stop the song in the middle, you have a few options.    You can just click on the
Return Button to go back to the Song Menu.    Or you can go the File Menu Item at the top 
Menu Bar and select Return to Main Menu to go back to the beginning of the program or you 
can select Exit to quit the program entirely.



TORNADO WATCH

In this activity, answer questions on the climate, natural environment and geography of the United States.    

Rules
To learn the rules, click on the Rules button and read the text that comes up.

Start
To start the activity , click on the start button.    A tornado zooms across a map of the country as you attempt to 
answer questions. 



Question
To play the game, read the question displayed in the yellow area under the map.    

Answer Choices
The answer choices are shown below the question.    Select one of the answer choices that are displayed.    The more 
questions you answer correctly the less damage the tornado does.    You only have one chance to answer each 
question.

Hint Button
Click on the Hint button under the answer choices, so that you can read a hint to help answer the question.    The hint
is displayed under the answer choices.

Next Button
After you have answered a question, click on the Next button at the right of the hint area to go on.    The Tornado 
Watch    is over after 10 questions.

End of the activity
Click on the OK button at the end of the activity.    The Tornado Watch    introduction screen will be displayed and 
you again have the choice of either starting a new game or exiting to the Activity menu.

Stopping the activity
To stop in the middle of the activity, go the File Menu Item in Menu Bar and select Return to Main Menu to go back 
to the beginning of the program or select Exit to quit the program entirely.

Exiting the activity
Click on the Exit sign of the Activity Introduction screen to go back to the Activity Menu.



STATE CAPITAL QUEST

Do you know what the capitals of all fifty states are?    Challenge yourself with this activity.    

Rules
To learn the rules, click on the Rules button and read the text that comes up.

Start
To start the activity , click on the start button.    A map of the United States will be displayed 



Question
To play the game, find the state that is highlighted in a different color and whose name appears at the top of the map.

Answer Choices
The answer choices are shown below the map.    Select one of the three answer choices that are displayed.    You get 
two chances to answer.    If you get it on the first try you will get a golden star; you will get a silver star with a 
correct answer on the second try.    Try to get a perfect score for a surprise!

Next Button
After you have answered a question, go on to the next question by clicking on the Next button.    There are 10 
questions per challenge.

End of the activity
Click on the OK button at the end of the activity to go back to the Activity Menu.

Stopping the activity
To stop in the middle of the activity, go the File Menu Item at the top Menu Bar and select Exit to quit the program 
entirely; or select Return to Main Menu to go back to the beginning of the program.



WHAT STATE CAN IT BE?

This is a great activity for children (and adults!) to learn about the locations of the 50 states.    

Rules
To learn the rules, click on the Rules button and read the text that comes up.

Start
To start the activity , click on the start button.    A map of the United States will be displayed. 



Question
To play the game, find the state that is highlighted in a different color and try to identify it.        

Answer Choices
The answer choices are shown below the map.    Select one of the three answer choices that are displayed.    You get 
two chances to answer.    If you get it on the first try you will get a golden seal; you will get a silver seal with a 
correct answer on the second try.    Try to get a perfect score for a surprise!

Next Button
After you have answered a question, go on to the next question by clicking on the Next button.    There are 10 
questions per challenge.

End of the activity
Click on the OK button at the end of the activity to go back to the Activity Menu.

Stopping the activity
To stop in the middle of the activity, go the File Menu Item at the top Menu Bar and select Exit to quit the program 
entirely; or select Return to Main Menu to go back to the beginning of the program.



DIZZY AUNT LULU'S PHOTO ALBUM

In this activity, your task is to help Dizzy Aunt Lulu label photos of the many sights and famous landmarks she saw 
on a recent tour of the U.S.    

Rules
To learn the rules of the activity, click on the Rules button and read the text that comes up.

Start
To start the activity , click on the start button.    Aunt Lulus table top will appear. 



Question
To play the game, identify the photo displayed in Aunt Lulus album and label it.        

Answer Choices
The label choices are shown below the album.    Select one of the three labels that are displayed.    You get two 
chances to answer.    If you label the photo correctly on the first or second try, a piece of candy will fall into your 
cup.

Next Button
After you have answered a question, go on to the next question by clicking on the button that looks like a fancy 
arrow at the bottom right-hand corner of the album.    There are 10 questions per visit with Aunt Lulu.

Hint
On the page of the album opposite the photo is a note Aunt Lulu made to herself about the place in the photo.    Click
on this for a Hint of the location.

End of the activity
Click on the End button at the end of the activity to go back to the Activity Menu.

Stopping the activity
To stop in the middle of the activity, go the File Menu Item at the top Menu Bar and select Exit to quit the program 
entirely; or select Return to Main Menu to go back to the beginning of the program.



5. More from MediAlive!
Demos

Other MediAlive products can be previewed in this section.    

Europe Alive 1.0

Catch a glimpse of Europe Alive where you can learn about 15 countries and 20 major European cities!    Click on 
the Europe Alive Button.

Asia Alive 1.0

Catch a glimpse of Asia Alive where you can learn about 15 countries and 20 major cities in Asia!    Click on the 
Asia Alive Button.

6. Features & Preferences
(See the original with revisions)

7. Questions & Comments
Technical Support

Add the following:

We would like to hear your comments and feedback on America Alive    and how you use it with your family or 
classroom.      We appreciate your interest in our products. 




